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Getting Started Processing TDOA 
and FDOA Data with ODTK 

1 Introduction 

ODTK can simulate and process numerous flavors of time difference of arrival (TDOA) and fre-

quency difference of arrival (FDOA) measurements. You can model these measurements in the 

following ways: 

• a single receiver processing a single signal that has been propagated along two different 

paths 

• two receivers processing a single signal 

• a single receiver processing two separate signals 

The specific types of measurements modeled in ODTK are listed in the table below. The strand 

notation in the table describes the signal path: E (emitter), S (satellite/satellite-based receiver), R 

(ground receiver), “-“ (sequential connection), and “,” (parallel connection). 
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Measurement Strand Description 

TDOA E-S,S-R A signal emitted from a single ground-based emitter 

travels through two relay satellites to a common 

ground-based receiver. 

FDOA E-S,S-R A signal emitted from a single ground-based emitter 

travels through two relay satellites to a common 

ground-based receiver. 

TDOA Dot E-S,S-R This is the time derivative of TDOA. 

SD TDOA E,E-S,S-R Signals emitted from two ground-based emitters 

travel through two relay satellites to a common 

ground-based receiver. This method cancels out most 

satellite-based errors and downlink errors. 

SD FDOA E,E-S,S-R Signals emitted from two ground-based emitters 

travel through two relay satellites to a common 

ground-based receiver. This method cancels out most 

satellite-based errors and downlink errors. 

TDOA 2 Receivers E-S,S-R,R A signal emitted from a single ground-based emitter 

travels through two relay satellites to two ground-

based receivers. 

FDOA 2 Receivers E-S,S-R,R A signal emitted from a single ground-based emitter 

travels through two relay satellites to two ground-

based receivers. 

TDOA 2 Emitters E,E-S-R Signals emitted from two ground-based emitters 

travel through a relay satellite to a single ground-

based receiver. 

FDOA 2 Emitters E,E-S-R Signals emitted from two ground-based emitters 

travel through a relay satellite to a single ground-

based receiver. 

TDOA Dot 2 Emitters E,E-S-R This is the time derivative of TDOA 2 Emitters. 

SB TDOA E-S,S A signal emitted from a single ground-based emitter 

travels to two satellite-based receivers. 

SB FDOA E-S,S A signal emitted from a single ground-based emitter 

travels to two satellite-based receivers. 

SB TDOA Dot E-S,S This is the time derivative of SB TDOA. 
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SB TDOA SBE E-S,S A signal emitted from a single space-based emitter 

travels to two satellite-based receivers. 

SB FDOA SBE E-S,S A signal emitted from a single space-based emitter 

travels to two satellite-based receivers. 

GroundTDOA E-R,R A signal emitted from a single space-based emitter 

travels to two ground-based receivers. 

GroundFDOA 

 

E-R,R A signal emitted from a single space-based emitter 

travels to two ground-based receivers. 

GroundFDOADot E-R,R This is the time derivative of GroundFDOA. 

 

In the following exercises, you will explore the TDOA, FDOA, SB TDOA, SB FDOA, SD TDOA, and 

SD FDOA measurement types. For TDOA and FDOA measurements, an emitted signal travels via 

relay satellites along two different routes to a common receiver, where the time of arrival (TOA) 

and the frequency of arrival (FOA) along each route are recorded. The difference in TOA between 

the two signal paths forms a TDOA measurement, and the difference in FOA between the two 

paths forms a FDOA measurement. TDOA and FDOA measurements can support orbit determina-

tion, geolocation of stationary Earth-fixed objects, or both. Operational use cases for TDOA and 

FDOA may use a one emitter or two or more emitters simultaneously. 

In ODTK, a signal path begins at an immobile Earth-based emitter. The signal is relayed through a 

single satellite and ends at a ground-based receiver. TDOA and FDOA measurements may exist 

when two satellites (signal paths) are concurrently visible to the emitter and its receiver. Time 

differences of signal reception are in the sense of Path 2 minus Path 1, where the time tag is rela-

tive to Path 1. For example, a positive TDOA observation indicates that the time of signal travel 

along Path 2 is longer than the time of signal travel along Path 1. The measurements may be 

tagged at the moment of ground receipt (TDOA/FDOA) or satellite receipt (SB TDOA/SB FDOA). If 

a measurement is tagged at "satellite-receipt" time, this implies that the effects of the satellite 

relay transponder and the downlink to the receiver are excluded from the observation. 

2 ODTK configuration 

To accurately simulate TDOA and FDOA measurements, or to use TDOA and FDOA measurements 

for estimation, certain objects must be present and properly configured in ODTK. 

Processing of ground-based or space-based measurements requires an Emitter object attached 

to a Facility object. You must specify the transmission frequency of the emitter to accurately 

model FDOA measurements and to account for ionospheric effects on TDOA measurements. 

ODTK also uses the transmission frequency for transponder selection on the relay satellites dur-

ing simulation of measurements and for transponder selection during estimation if an explicit 
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transponder ID is not specified in the tracking data. To simulate or process measurements, the 

two relay satellites must also be within the visibility constraints of the emitter and receiver. 

ODTK can estimate the location of a Facility hosting an Emitter if the location is not precisely 

known. 

2.1 Ground-based measurements 

The ODTK objects required for processing TDOA and FDOA measurements tagged at ground-re-

ceipt time are: an Emitter object, two (2) Satellite objects equipped with relay transponders, and 

a Facility object as the signal receiver. The receiver facility does not need be under or within the 

same TrackingSystem object as the emitter. The MeasurementStatistics properties are associated 

with the receiver facility. 

Simulation of ground-based TDOA and FDOA measurements is based on the construction of 

tracking strands that start with the emitter, pass through the relay satellites of two (2) different 

routes, and end at the receiver facility. Strands are possible for all emitters, all satellites hosting 

relay transponders, and all facilities with TDOA or FDOA measurement statistics. 

TDOA measurements depend on (bold indicates estimation is possible): 

• The location of the facility hosting the emitter 

• The troposphere and ionosphere settings of the facility hosting the emitter 

• The orbits, or trajectories, of the relays 

• The transponder delays of the relays 

• The troposphere and ionosphere settings of the receiver facility 

• The location of the receiver facility 

• A measurement bias 

ODTK can estimate the delay for each transponder and model two or more transponders on each 

relay satellite. Selection of the transponder for ODTK to use in a particular observation is based 

first on a transponder ID provided as part of the measurement (real data only) and secondly by 

the frequency of the emitter. By default, ODTK configures transponders to have a very large 

bandwidth to simply construction of basic simulations. Simulation and estimation do not model 

ground-system delays, so you must remove ground-system delays from observations when using 

two or more ground strands. However, when using a single ground strand, the receiver measure-

ment bias can approximately compensate for ground delay. 

FDOA measurements depend on (bold indicates estimation is possible): 

• The location of the facility hosting the emitter 

• The frequency of the emitted signal 
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• The orbits, or trajectories, of the relays 

• The frequency translation through the relay transponders 

• The location of the receiver facility 

In addition to TDOA and FDOA measurements, ODTK can also process the time rate of change in 

TDOA (TDOA Dot), singly differenced TDOA, and singly differenced FDOA measurements. ODTK 

models TDOA Dot as the instantaneous time derivative of TDOA. Singly differenced TDOA and 

FDOA measurements are differences between the TDOA and FDOA measurements for two emit-

ters whose signals traverse the same two relay satellites, though possibly using different tran-

sponders, and are received at the same receiver facility. All of the descriptions characterizing 

TDOA measurements above also apply to TDOA Dot measurements. 

2.2 Space-based measurements 

The ODTK objects required for processing space-based TDOA (SB TDOA) and space-based FDOA 

(SB FDOA) measurements tagged at satellite-receipt time are an Emitter object and two (2) Satel-

lite objects. The satellite objects do not require relay transponders. The MeasurementStatistics 

properties are associated with one of the satellites. 

Simulation of SB TDOA and SB FDOA measurements is based on the construction of tracking 

strands that start with the emitter and end at two (2) satellites. Strands are possible between all 

emitters and satellites providing one (or both) of the satellites has SB TDOA or SB FDOA Meas-

urementStatistics properties active. 

SB TDOA measurements depend on (bold indicates estimation is possible): 

• The location of the facility hosting the emitter 

• The troposphere and ionosphere settings of the facility hosting the emitter 

• The orbits, or trajectories, of the relays 

• A measurement bias 

Space-based measurements require that all ground delays and satellite transponder delays be 

removed. 

SB FDOA measurements depend on (bold indicates estimation is possible): 

• The location of the facility hosting the emitter 

• The frequency of the emitted signal 

• The orbits, or trajectories, of the relays 
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In addition to SB TDOA and SB FDOA measurements, ODTK can also process the time rate of 

change in SB TDOA (SB TDOA Dot) as a measurement. SB TDOA Dot is modeled as the instantane-

ous time derivative of SB TDOA. 

3 TDOA and FDOA tracking data 

ODTK can simulate ground-based and space-based TDOA, FDOA, and TDOA Dot measurements in 

the GEOLOC or generic-observation (gobs) format. These same data can be input for estimation. 

The generic-observation format is a binary format that has the benefit of maintaining the full 

precision of simulated measurements. It is only useful, however, for simulated measurements, 

since the format is not published. GEOLOC is a simple ASCII format that is documented as part of 

the ODTK help system and is therefore the best way to import real TDOA and FDOA measure-

ments. ODTK can also process singly differenced ground-based TDOA and singly differenced 

ground-based FDOA measurements. There are two ways in which you can import the differenced 

measurements: directly via the GEOLOC format or indirectly, where the difference measure-

ments are computed from individual TDOA and FDOA measurements upon loading into ODTK 

from either generic-observation for GEOLOC tracking data files. Processing single-difference 

measurements in this latter manner is the subject of one of the exercises below. 

4 Simultaneous orbit determination 

ODTK can regard the ephemerides of relay-satellites in different ways while processing TDOA and 

FDOA measurements. 

• The relay-satellite orbits may be simultaneously estimated with any unknown emitter 

locations. This is the recommended mode for processing ground-tagged measurements. 

In some cases, all emitter locations may be known, in which case, estimation of the or-

bits is the primary objective. Simultaneous orbit determination will significantly improve 

the orbit and covariance (at the expense of more solution time). 

• Reference ephemerides may be provided for the satellites, thus limiting estimation to 

emitter location(s) only. In the case of space-based measurements, an a priori estimate 

of the orbit is required to back up the observations to the time of satellite receipt. In 

this case, you have the option of using reference ephemerides (preferably the same 

ephemerides used in the construction of the measurement) or estimating the orbits 

while estimating the emitter location(s). 

5 Sample TDOA and FDOA simulation 

The following procedure steps through a simple simulation of ground-based TDOA and FDOA 

tracking data. You will use ground-based TDOA and FDOA measurements to simultaneously esti-

mate two (2) satellite orbits and two (2) emitters with uncertain locations. You will also use data 

from three well-known emitters. Due to the large amount of input required to initially set up 
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such an exercise, you will import some of the required objects in a preconfigured status via an 

ODTK demonstration scenario. 

1. Start ODTK. 

2. Load the GS_GeoLocation demonstration scenario located in your ODTK install area un-

der the directory: 

<install directory>\ODTK\UserData\DemoScenarios\Geolocation with TDOA and FDOA 

Measurements 

After loading the scenario, go to the File menu and perform a Save As operation to save 

a copy of the scenario to your local user area. 

3. Check that the appropriate measurement statistics (TDOA, FDOA) exist under the "Mon-

itor" Facility object, which serves as the receiver facility for this example. 

4. Check the properties of each Emitter object. Each emitter has its own transmit fre-

quency, and the facilities hosting "unknown" emitters are configured for estimation of 

their locations.  

5. To simulate ground-based TDOA and FDOA measurements routed through the geosta-

tionary satellites, add transponders to each satellite and set each transponder type to 

"Relay". When the transponder type changes, new transponder attributes appear under 

a heading of RFInfo. The center frequency and bandwidth fields define the range of re-

ceived frequencies for this transponder. The default values, which are designed to cover 

all commonly used frequencies, are adequate for this exercise, but the modeling real 

systems will likely require that two or more transponders, each with its own frequency 

range, be added to the relay satellites. During the creation of simulated measurements, 

frequency-based selection is used to pick the correct transponder. During estimation, 

ODTK first attempts explicit selection via the transponder ID with frequency-based se-

lection used if there is no transponder ID. AddFreqTranslation is the frequency transla-

tion that is added to the received signal in generating the downlink carrier frequency. 

For example, if a ground signal is received at 14.3 GHz and a frequency translation of -

2300 MHz is specified, the satellite transponder broadcasts the relayed signal at 12.0 

GHz. Use the default value of -2300 MHz for this exercise. 

6. Add a simulator object to the scenario. 

7. Change the time step for the simulation to 2 minutes and change the stop time of the 

simulation to “15 Jun 2006 00:00:00.00 UTCG”. 

8. Change the type of the output observation file to be “Generic Simulation” (.gobs). 

9. Double-click the TrackingStrandList attribute of the simulator to bring up the list of as-

signed tracking strands, which should be empty. Remember, an empty tracking strand 

list means "use all strands." Click the Add button to view the list of available strands; 
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you will see that only one strand is available. Cancel out of editing the TrackingStrand-

List. (Optional: Temporarily change one of the transponders to a type other than relay, 

then re-examine the available tracking strands for the simulator. Note that selecting the 

Add button no longer displays a selection window because no tracking strands are avail-

able. This is because simulation of ground-based TDOA and FDOA measurements re-

quires that the satellites have relay transponders. Change the transponder type back to 

relay.) 

10. Run the simulation. This can take several minutes. The simulator initially perturbs the 

unknown emitter locations and the satellite initial conditions by a varying amount. 

11. Now add a Filter object to the scenario to perform orbit determination using the simu-

lated measurements. 

12. Activate the SmootherData.Generate attribute of the Filter object for the duration of 

the filter run. 

13. Bring up the Dynamic Product Selector from the View menu and create a dynamic Meas-

urement Update report for either of the satellites in the scenario. 

14. Run the Filter object while monitoring the dynamic report. Once the filter appears to be 

running correctly, close the dynamic report window to allow the run to finish more 

quickly. This process can take several minutes to complete. 

15. When the filter is finished, examine its output using the Static Product Builder. Try using 

the “Residuals” graph style to view TDOA then FDOA residuals. Use the data-limiting se-

lections on the Inputs tab of the Static Product Builder to create separate graphs for 

each measurement type. The TDOA residuals are reported in nanoseconds and the 

FDOA residuals are reported in Hz.  

16. Generate a “Position Uncertainty” graph containing information for both satellites. The 

data for the two satellites are almost identical because the satellites are close to each 

other in geostationary orbit and experience nearly identical tracking geometry. 

17. It is possible to difference the estimated state from the simulated truth state to see how 

closely the filter recovered the original simulated state. The first step in this process is to 

run the State Difference Tool (StateDiffTool.htm), which you can launch using the  

toolbar button. Select the filter output (.filrun) as the target file and the simulator out-

put (.simrun) as the reference file; these files will be located in your DataArchive direc-

tory. Click "Go!" to generate the state-difference output. 

18. Now select the State Difference output (.difrun) as the data-source file for the Static 

Product Builder. On the Inputs tab of the Static Product Builder, limit reporting to the 

GEO_1 satellite only. Then generate the “Differenced Pos R”, “Differenced Pos I”, and 

“Differenced Pos C” graphs to see how the filter/simulator radial, in-track and cross-

track position differences compare to the filter covariance. Change the data limiting on 

the Inputs tab to create the same graphs for the GEO_2 satellites to see those results. 
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19. Change the data limiting for Facility Name on the Inputs tab of the Static Product Builder 

to show only information for the Unknown1 emitter. Now generate the “Differenced 

Fac Loc Topo” graph to see how well the Filter was able to recover the deviated loca-

tion. Generate the same graph and examine the results for the Unknown2 emitter. 

20. Now create a new smoother object. Assign the .rough file created by the filter as the in-

put for the smoother by adding it to the Input.Files list. 

21. Run the smoother. 

22. Run the State Difference tool again, this time using the smoother output (.smtrun) as 

the target file and the simulator output (.simrun) as the reference file. Select an output 

file name that will not write over your prior filter-simulator difference run should you 

want to compare the two results. 

23. Generate the “Differenced Fac Loc Topo” report for the Facility “Unknown1” using the 

new smoother-simulator difference output. The smoother does not improve the esti-

mate of the unknown emitter locations. Feel free to also examine the orbit differences, 

transponder delay differences, etc. 

24. Run the State Difference tool again, using the smoother output (.smtrun) as the target 

file and the filter output (.filrun) as the reference file. Select an output file name that 

will not write over your prior filter-simulator or smoother-simulator difference runs. 

25. Select the latest State Difference output file from Step 24 above (smoother minus filter) 

as the data-input file for the static product builder. Generate a “Position Consistency” 

graph, then a “Facility Location Consistency” graph. Filter/smoother consistency tests 

are good indicators of the sufficiency of the adopted model. Ideally, 99% of the test-sta-

tistic values for each parameter should remain between -3 and 3. All parameters per-

form well in this simulation. 

26. Extra Credit: Configure and run the filter to process only TDOA measurements; then fil-

ter only FDOA measurements. Note the amount of time required in each case for the 

filter to significantly reduce the uncertainty in the emitter locations, and compare to the 

results when two data types were processed together. 

6 Sample SB TDOA and SB FDOA Simulation 

The following procedure steps through a simple simulation of space-based TDOA and FDOA 

tracking data tagged at the receipt time of the satellites. You will use space-based TDOA and 

FDOA measurements to simultaneously estimate two emitters with uncertain locations, given 

the reference ephemerides of the receiver satellites. You will also use data from three well-

known emitters. Due to the large amount of input required to initially set up such an exercise, 

you will import some of the required objects in a preconfigured status via another ODTK demon-

stration scenario. The space-based exercise is streamlined relative to the earlier ground-based 

exercise to point out the differences in the processing and to avoid redundant tasks. 
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1. Start ODTK. 

2. Load the GS_GeoLocation_II scenario located in your ODTK install area under the direc-

tory: 

<install directory>\ODTK\UserData\DemoScenarios\Geolocation with TDOA and FDOA 

Measurements 

After loading the scenario, go to the File menu and perform a Save As operation to save 

a copy of the scenario to your local user area. 

3. Check that the appropriate measurement statistics (SB TDOA, SB FDOA) exist under one 

of the satellite objects. In this example, the measurement statistics are associated with 

GEO_1. The measurement names are preceded by "SB", indicating that they are space-

based measurements. 

4. Check that both satellites are configured to use a reference trajectory ephemeris source 

(Satellite.EstimateOrbit is "false"). Verify that the reference trajectory refers to a file 

with "truth" in the filename. 

5. Run the simulator. This can take several minutes. 

6. Bring up the Dynamic Product Selector from the View menu and create a dynamic Meas-

urement Update report for either of the satellites in the scenario. 

7. Run the Filter. No updates appear because the filter is not estimating the satellite orbit. 

Close the dynamic report window to allow the run to finish more quickly. This process 

can take several minutes to complete. 

8. When the filter is finished, plot residuals and histograms for “SB TDOA” and “SB FDOA”. 

The “SB TDOA” residuals will be reported in nanoseconds and the “SB FDOA” residuals 

will be reported in Hz. Leave these plots open for a later comparison. 

9. Use the State Difference Tool to generate a Filter/Simulator difference run file, where 

the (.simrun) file is the reference file. 

10. Select the difference run (.difrun) output just created as the input file for the Static 

Product Builder. Generate the “Differenced Fac Loc Topo” graph to see how well the Fil-

ter was able to recover the deviated emitter locations. 

11. Create a new smoother object. Select the .rough file created by the filter as the input for 

the smoother by adding it to the Input.Files list. 

12. Run the smoother. Recall from the last exercise that the smoother did not provide any 

additional improvement relative to the filter result for station-location estimation, so 

the smoother output does not need to be examined directly. 
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13. Generate a difference run using the smoother output (.smtrun) as the target file and the 

filter output (.filrun) as the reference file. Select a difference-output file name that will 

not write over prior output. 

14. Using the new difference output file (filter/smoother) as the input to the static product 

builder, generate the “Facility Location Consistency” graph. Leave this plot open for a 

later comparison. 

15. The filter and smoother that you just ran had an unfair advantage. Although the satellite 

orbits were not estimated, they were provided to the estimator without error. Now, 

change each satellite configuration to reference the supplied ephemerides having "ref-

erence" in the filename. The supplied reference ephemerides have one-sigma (1 σ ) er-

ror uncertainties of 10, 50, and 100 meters in the radial, in-track, and cross-track direc-

tions, respectively. 

16. Select a filter-output file name that will not write over prior output. 

17. Run the filter. 

18. When the filter is finished, plot residuals and histograms for “SB TDOA” and “SB FDOA”. 

Compare these plots to the ones you generated using the truth ephemeris. There is a 

mild periodic pattern in the “SB FDOA” residuals plot; otherwise, the results compare 

favorably. 

19. Generate a new filter/simulator difference run using the output from the new filter run. 

20. Examine the errors in the emitter-location estimates relative to the filter covariance us-

ing the “Differenced Fac Loc Topo” graph. The errors are well outside the covariance 

bounds of the filter. This is the result of not accounting for the errors in the satellite 

ephemeris. Of course, you would not have the luxury of comparing against the truth 

when processing actual tracking data. 

21. Select a smoother-output file name that will not write over prior output. 

22. Run the smoother. 

23. Generate a difference run using the smoother output (.smtrun) as the target file and the 

filter output (.filrun) as the reference file. Select a difference-output file name that will 

not write over prior output. 

24. Using the new difference output file (filter/smoother) as the input to the Static Product 

Builder, generate the “Facility Location Consistency” graph. Since the test statistic for 

each parameter should remain between -3 and 3, 99% of the time, this plot indicates a 

modeling problem that could adversely affect the results of the estimation process. This 

indicates a need for highly accurate reference ephemerides to support emitter-location 

estimation. 
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25. Start Extra Credit: Investigate whether or not estimating satellite orbits can improve the 

results. In the following steps, you will estimate the satellite orbits to see if that can im-

prove your results. 

26. Change the EstimateOrbit settings on both satellites to true. 

27. Use the InitialStateTool to generate initial conditions for both satellites from the “refer-

ence” ephemeris files. Select the epoch for each set of initial conditions as the start time 

in the ephemeris file. 

28. Redo steps 17-24. Does this simulation indicate possible improvement in results by esti-

mating the orbit? While this extra credit part of the exercise is interesting, it does not 

really model what would happen with real data. With real data processing, the reported 

observations are a combination of the actual observations minus the predicted part of 

the observation between relay reception and ground station reception. 

7 Sample single-differenced TDOA and FDOA simulation 

The following procedure outlines the steps necessary to simulate nondifferenced (ND) ground-

based TDOA and FDOA tracking data and then process the data as single-differenced (SD) meas-

urements. In this case, all of the emitter locations will be known and the primary objective will be 

to estimate the orbits of the two relay satellites Due to the large amount of input required to ini-

tially set up such an exercise, you will import some of the required objects in a preconfigured sta-

tus via another ODTK demonstration scenario. 

1. Start ODTK 

2. Load the GS_GeoLocation_SD scenario located in your ODTK install area under the direc-

tory:  

 

<install directory>\ODTK\UserData\DemoScenarios\Geolocation with TDOA and FDOA 

Measurements 

After loading the scenario, go to the File menu and perform a Save As operation to save 

a copy of the scenario to your local user area.  

3. Examine the measurement statistics for the Monitor facility. Both SD and ND measure-

ment statistics are defined. The statistics for the SD and ND measurements are related 

via: 

𝜎𝑆𝐷 = √2𝜎𝑁𝐷
2  

4. Set the ReferenceEmitter property of the Monitor facility to point to the emitter named 

Reference. This step is required to support the generation of SD measurements when 
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the filter is run. The SD measurements will be computed as TDOA or FDOA for each 

emitter minus the TDOA or FDOA for the reference emitter. The number of each type of 

SD measurement available at each time will therefore be one less than the number of 

ND measurements available at that time. 

5. Check the enabled MeasTypes on the simulator and filter objects. The simulator does 

not have the SD measurement types enabled, while the filter does not have the ND 

measurement types enabled. The simulator cannot simulate SD measurements directly. 

The filter will construct the SD measurements upon loading of the ND measurements if 

the following conditions are met: 

• SD measurements are specified in the MeasTypes for the filter. 

• SD measurements are specified in the MeasTypes for the satellites. 

• SD measurements are specified in the MeasurementStatistics for the receive facil-

ity. 

• A reference emitter is specified in the properties of the receive facility. 

6. Run the simulation. This may take several minutes.  

7. Bring up the Dynamic Product Selector from the View menu and create a dynamic Meas-

urement Update report for either of the satellites in the scenario.  

8. Run the Filter. Monitor the filter run using the dynamic report. Once you are satisfied 

that the filter is running correctly, close the dynamic report window to allow the run to 

finish more quickly. This process may take several minutes to complete. 

9. Generate “Residuals” graphs to view SD TDOA then SD FDOA residuals. The SD TDOA re-

siduals will be reported in nanoseconds and the SD FDOA residuals will be reported in 

Hz. Also generate residual histograms for each type of measurement. 

10. Generate a “Position Uncertainty” graph containing information for both satellites. The 

data for the two satellites is almost identical. This is due to the fact that the satellites 

are close to each other in geostationary orbit and experience nearly identical tracking 

geometry. Leave this graph around for a later comparison. 

11. Generate a difference run using the filter output (.filrun) as the target file and the simu-

lator output (.simrun) as the reference file. Select an output file name that will not over-

write your prior difference runs. 

12. Use the difference output to generate the “Differenced Pos R”, “Differenced Pos I”, and 

“Differenced Pos C” graphs for each satellite. The differences lie mostly within the two-

sigma covariance bounds with exceptions mainly limited to the radial direction. Also 

note the increasing envelope of the in-track uncertainty. 



 

Processing TDOA and FDOA Data  14 

13. Assign the rough file created by the filter as the input for the smoother by adding it to 

the Input.Files list. 

14. Run the smoother.  

15. Generate a difference run using the smoother output (.smtrun) as the target file and the 

simulator output (.simrun) as the reference file. Select an output file name that will not 

overwrite your prior filter-simulator difference run if you would like to compare the two 

results. 

16. Use the difference output to generate the “Differenced Pos R”, “Differenced Pos I”, and 

“Differenced Pos C” graphs for each satellite. The excursions of the radial difference out-

side the two-sigma covariance bounds in the radial direction are more severe in the 

smoother result. The smoother appears to give good improvement in the in-track direc-

tion, but the uncertainty is still large. 

17. Generate a difference run using the smoother output (.smtrun) as the target file and the 

filter output (.filrun) as the reference file. Select an output file name that will not over-

write your prior filter-simulator or smoother-simulator difference runs. 

18. Using the new difference output file (filter/smoother) as the input to the static product 

builder, generate a “Position Consistency” graph. While the in-track and cross-track con-

sistency looks good, the radial consistency graph indicates a possible modeling problem. 

While it has not yet been proven, the current theory is that this inconsistency is the re-

sult of not accounting for the correlation between the single-differenced measure-

ments. 

19. Extra Credit: The effect of ignoring the correlation between the measurements is to tell 

the filter that it has more information on the orbits than it really does. We can partially 

compensate for this misinformation by increasing the noise on the measurements. Try 

increasing the noise on the single differenced measurements and rerunning the filter 

and smoother. Do the results appear to improve? How do the measurement residual 

plots and residual histogram plots look? 


